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No two places are affected by 

climate change in the same way. 

Socio-economic and environmental 

decisions, past and future, lead to 

variances in the vulnerability of 

people to the impact of climate 

change. These decisions impact land 

use, inequity, marginalisation and 

governance2.  

Why map climate risk and 
vulnerability? A climate risk and 
vulnerability assessment (CRVA) map 
is a tool to communicate  
climate risk and identify potential 

impacts on society. CRVA maps 

help prioritise, target and plan 

adaptation investments to the needs 

of a place.  

This guidance document 

describes a new CRVA approach 

that can be easily updated from 

readily available datasets. Figure 1 

describes the conceptual 

methodology used in this project. 

This is a working document and 

will continue to be updated.  

MAPPING CLIMATE 

RISK AND 

VULNERABILITY WITH  

Several factors affect climate risk. What 

these are and the extent of their influence 

varies from place to place. Therefore, 

climate action is needed on all fronts: 

“everything, everywhere, all at once.”1  
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PRODUCING A CLIMATE RISK 

AND  

VULNERABILITY 

ASSESSMENT  

(CRVA) MAP FOR 

BIRMINGHAM  

  
This guidance document describes the GIS techniques used 

to develop a CRVA map for Birmingham; co-created by the 

WM-Air project group and Birmingham City Council.  
  
How is a CRVA map built?  
A CRVA map requires several layers of data that would 

contribute to climate risk. The data parameters could include: 

Physical, e.g. urban form, flood zones; Environmental, e.g. 

temperature, air quality; and Social, e.g. health, social 

deprivation. Each data layer is standardised in terms of both 

spatial scale and values. Then, they can be easily combined 

into one single layer that represented the total climate risk 

across the map. Therefore, it is important to note that this 

CRVA map is not an absolute assessment of climate risk and 

vulnerability, but only relative within the boundary of the area 

being assessed, which in this case, is the Birmingham city 

boundary. This means that it cannot be directly compared 

with another city or region.  
  
What tools and functions are required for a CRVA map? 

A Geographic Information System (GIS) application is 

required to build a CRVA map. Throughout this guidance 

document, the Quantum GIS (QGIS)3 free, open-source 

application was used; the approach is also compatible with 

ArcGIS. Several functions are used, but the main CRVA build 

uses raster (or matrix) algebra. Data layers are divided into 

small grids (cells) of equal dimension, with each cell 

comprising a single value.  
  
Why produce a CRVA map of Birmingham?  
Birmingham is part of the West Midlands conurbation; the  

Table 1. Key information on each layer used to build the CRVA map  

largest metropolitan county in the United Kingdom4. 

Birmingham’s city centre has undergone significant 

transformation in recent decades, attracting unprecedented 

levels of investment, development, and opportunities. At the 

same time, the city faces the challenges of climate change, 

increased economic disparity, and socio-environmental 

Figure 1.  Multiple layers of data are converted and combined to create a single CRVA map layer   

. Gather data layers 1   

3 . Score layers   

Bin   Layer 1    Layer 11    …   
0.05   0.06   4   …   
0.10   0.24   15   ….   
0.15   0.31   47   …   
...   ...   ...   …   

1.00   1.00   259   ...   

. Establish quantile bins 2   

4 . Sum for total CRVA score   

Analyse   

Transform   

Combine   
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change5. Future developments must consider these 

challenges from their inception to reduce climate risk and 

vulnerability. A CRVA provides the means to understand and 

address these challenges, direct service priorities for the 

Levelling Up agenda, and help achieve the city’s stated 

ambitions around a Just Transition. Its adoption would 

position Birmingham City Council as a A-class city and a 

global leader in transparency and bold climate action6.  
  
Data used for this CRVA map of Birmingham This CRVA 

map used 11 datasets, shown in Table 1. They include 

physical, environmental and social data that represent 

climate risk as a hazard, vulnerability or exposure. Most data 

are open source or publicly available, so it is a replicable 

process for other regions to produce a similar CRVA map. It 

also means that when future revisions of data are available, 

they can be loaded in as a means of monitoring and 

evaluating processes in reducing climate risk.   
  
Putting the final CRVA map together  
In Table 1, the required score ranges are described per layer. 

They were converted from the original data forms they were 

downloaded in, to a standardised format and score to be 

summed up easily - where for each layer, a score near to 0 

represents lower risk and a score near to 1 represents 

higher risk. Table 2 shows the conversion processes 

undertaken in GIS to conduct this standardisation process 

per layer. Once these were ready, the raster calculator was 

used to sum all the layers together. Currently, the layers 

have equal weighting for they are assumed to be of equal 

importance to the overall CRVA scores.  

Layer  Data type  Layer score parameters  

Fluvial flood risk (Flood zones 2 & 3)7,8  Physical  % coverage of a grid square by flood risk; grouped by 5%ile bins  

Pluvial flood risk (3.3 year return period)9  Physical  % coverage of a grid square by flood risk; grouped by 5%ile bins  

Open green space deficit10  Physical  % coverage of a grid square by green space; grouped by 5%ile bins  

Other green space deficit11  Physical  % coverage of a grid square by green space; grouped by 5%ile bins  

Tree canopy cover deficit12  Physical  % coverage of a grid square by tree canopy; grouped by 5%ile bins  

Local climate zones13  Physical  0 = completely open space, 1 = most densely built-up, high-rise*  

Nitrogen dioxide (NO2) concentration**  Environmental  Mean annual concentration per grid square; grouped by 5%ile bins  

Annual fine particulate (PM2.5) concentration**  Environmental  Mean annual concentration per grid square; grouped by 5%ile bins  

Surface temperature (summer daily max)16  Environmental  Temperature per grid square; grouped by 5%ile bins  

Indices of Multiple Deprivation (IMD)17  Social  Decile ranking per grid square  

Excess years life lost18  Social  Total years per grid square; grouped by 5%ile bins***  

* See Table 3 for the local climate zone breakdown and assigned CRVA scores  
** Data layers are a 2019 update of Zhong et al.14 created by the WM-Air project. Lower resolution open data is available from DEFRA15.  
*** Data provided are available to UK local authorities  
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What does the CRVA map look like?  
Figure 2 shows the CRVA map for Birmingham. CRVA scores 

vary across the city, with higher scores running through the 

city centre, and lower scores to the northeast and across 

parts of the southwest.  
  
How can the CRVA influence future decision-making for 

Birmingham?  
Birmingham is currently experiencing significant 

redevelopment; largely taking place around the city centre, 

where total CRVA scores are currently high. Including CRVA 

data at the inception of redevelopment plan-making has 

several benefits, including:  
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Figure 2.  Aerial view of Birmingham (left) 19 
, compared to the total CRVA score for Birmingham, at 100m raster cell resolution (right)   
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Table 2. Conversion process of each layer that forms the final CRVA map  

  Data layer  Converted layer  Conversion process  

 

  

 

  

 

• Convert using average resampling to 100m cell resolution, 
using the extent of the fishnet grid  

• Clip raster to the fishnet grid layer  
• Use quantile function to identify 5%ile bin values by setting 20 

quantiles; an incremental score of 0.05 per bin  

• Reclassify raster by table according to bin values  

 

  

 

  

 

• Convert using average resampling to 100m cell resolution, 
using the extent of the fishnet grid  

• Clip to the fishnet grid layer  
• Use quantile function to identify 5%ile bin values by setting 20 

quantiles; an incremental score of 0.05 per bin  

• Reclassify raster by table according to bin values  

 

  

 

  

 

• Rasterise flood zone 2 and 3 layers to 100m cell resolution and 

fishnet grid extent  

• Replace null values with 0 in both rasters  
• Sum both rasters and divide by 2  
• Clip raster to the fishnet grid layer  
• Use quantile function to identify 5%ile bin values by setting 20 

quantiles; an incremental score of 0.05 per bin  

• Reclassify raster by table according to bin values  

 

  

 

  

 

• Rasterise to 100m cell resolution and fishnet grid extent  
• Replace null values with 0  
• Clip raster to the fishnet grid layer  
• Use quantile function to identify 5%ile bin values by setting 20 

quantiles; an incremental score of 0.05 per bin  

• Reclassify raster by table according to bin values  

 

  

 

  

 

• Rasterise to 100m cell resolution and fishnet grid extent  
• Replace null values with 0  
• Use raster calculator to inverse values (1 - raster)  
• Clip raster to the fishnet grid layer  
• Use quantile function to identify 5%ile bin values by setting 20 

quantiles; an incremental score of 0.05 per bin  

• Reclassify raster by table according to bin values  
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• Rasterise  to 100m cell resolution and fishnet grid extent  
• Replace null values with 0  
• Use raster calculator to inverse values (1 - raster)  
• Clip raster to the fishnet grid layer  
• Use quantile function to identify 5%ile bin values by setting 20 

quantiles; an incremental score of 0.05 per bin  

• Reclassify raster by table according to bin values  

 

  Data layer  Converted layer  Conversion process  

 

    • Use raster calculator to convert data to binary form: (((merged 

raster > 0) = 1) + ((merged raster = 0) = 0) / 2  

 
  

• Reproject raster using average resampling to 100m cell 
resolution, using the extent of the fishnet grid  

• Clip to the fishnet grid layer  
• Use raster calculator to inverse values (1 - raster)  
• Use quantile function to identify 5%ile bin values by setting 20 

quantiles; an incremental score of 0.05 per bin  

• Reclassify raster by table according to bin values  

 

  

 

  

 

• Bilinear sampling interpolation to 100m cell resolution  
• Convert using average resampling to 100m cell resolution, 

using the extent of the fishnet grid  

• Clip raster to the fishnet grid layer  
• Use quantile function to identify 5%ile bin values by setting 20 

quantiles; an incremental score of 0.05 per bin  

• Reclassify raster by table according to bin values  

 

  

 

  

 

• Reproject raster to the GB coordinate reference system 
(EPSG:27700/OSGB 1936) to 100m cell resolution, using the 
extent of the fishnet grid and resample using the nearest 
neighbour method  

• Clip raster to the fishnet grid layer  
• Reclassify raster by table (see Table 3 for reclassification 

values)  

 

  

 

  

 

• Join attributes by location (summary) to fishnet grid  
• Rasterise fishnet with joined data to 100m cell resolution, using 

the decile majority value from the attribute table  

• Normalise raster layer 0-1   
• Use raster calculator to inverse values (1 - raster)  
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• Join attributes by location (summary) to fishnet grid  
• Rasterise fishnet with joined data to 100m cell resolution, using 

the total excess years life lost value from the attribute table  

• Use quantile function to identify 5%ile bin values by setting 20 

quantiles; an incremental score of 0.05 per bin  

• Reclassify raster by table according to bin values  

 
Not applicable  

  

 

• Use raster calculator to sum the total scores of each layer  

ADDITIONAL 

INFORMATION ON GIS 

TECHNIQUES  

  
Some of the GIS techniques described in Table 2 are 

explained in more detail here, so the processes can be 

replicated. This CRVA map used tools within the QGIS 

application (version 3.28.11 Firenze long-term release).  
  
Creating a fishnet grid  
Vector > Research Tools > Create Grid  
A fishnet grid is a vector layer, which is a conversion of 

another vector file into gridded squares. It is used for the 

CRVA map as the reference layer to align all raster 

conversions. The conversion for  Birmingham into its 

resulting fishnet grid is shown in Figure 4. This same 

process could be used to create hex grids for zonal 

statistics.  
  
Resampling: Bilinear interpolation  
Raster > Projections > Warp (Reproject)  
Resampling creates a new raster layer based on sampling 

from another raster layer. The reasons for doing this include 

reprojecting or aligning raster cells to a new grid size or 

position. Bilinear interpolation is a resampling method using 

the weighted four nearest cell centres20.  
  
Resampling: Nearest neighbour  
Raster > Projections > Warp (Reproject)  
Using the same process as bilinear interpolation, nearest 

neighbour resampling  is determined by the nearest cell 

centre on the input grid20.  

  
Joining attributes by location (summary) Processing 

toolbox > Vector general > Join attributes by location 

(summary)  
This process takes vector attributes and assigns them to 

each grid square. It is therefore a step before converting 

vector data into a raster layer.  
  
Identifying percentile values of continuous layer data  
Processing toolbox > GRASS > Raster > r.quantile This 

produces a table with the percentile boundaries of 

continuous raster data. To establish 5%ile bins, the number 

of quantiles is set to 20.   
Processing Toolbox > Raster Analysis > Reclassify by table 

After identifying the boundary ranges, the percentile break 

ranges can be set using reclassify by table.  
  
Normalising a raster layer 0-1  
Processing Toolbox >  SAGA > Raster calculus > raster 

normalisation  
This process quickly normalises a raster layer, where the 

highest value is scaled to 1 and the lowest scaled to 0. This 

is used when rasterising a layer creates cell values between 

0 and 255, reflective of colour band values.  
  
Local climate zone scoring  
Processing Toolbox > Raster Analysis > Reclassify by table 

After resampling, values are converted using Table 3.  
  
Converting total CRVA scores to other geographic 

boundaries  
Processing toolbox > Raster Analysis > Zonal statistics 

CRVA score can be averaged in accordance with vector files 

that include smaller boundaries, such as wards or hex grids.  

Table 3. Local climate zones and their CRVA scores. Graphics21 © American Meteorological Society. Used with permission.  
LCZ 1: Compact 

high-rise  
  

  
CRVA score 1.0  

LCZ 2: Compact 

mid-rise  
  

CRVA score 1.0  

LCZ 3: Compact 

low-rise  
  

CRVA score 0.9  
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LCZ 4: Open high-

rise  

   
CRVA score 0.8  

LCZ 5: Open mid-

rise   

CRVA score 0.7  

LCZ 6: Open low-

rise   

CRVA score 0.4  

LCZ 7: Lightweight 

low-rise  
   
CRVA score 0.5  

LCZ 8: Large low-

rise   

CRVA score 0.6  

LCZ 9: Sparsely 

built   

CRVA score 0.1  

LCZ 10: Heavy 

industry  

   
CRVA score 1.0  

LCZ A: Dense 

trees   

CRVA score 0.0  

LCZ B: Scattered 

trees   

CRVA score 0.0  

LCZ C: Bush, scrub  
  

  
CRVA score 0.0  

LCZ D: Low plants   

CRVA score 0.0  

LCZ E: Bare rock 

or paved   

CRVA score 0.0  

LCZ F: Bare soil or 

sand  
  

  
CRVA score 0.0  

LCZ G: Water   

CRVA score 0.0    
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